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Using the Z8 Encore!® Smart Flash 
Programmer

The Z8 Encore!® Smart Flash Programmer is a software tool used to auto-
mate programming of Z8 Encore!, Z8 Encore! MC, and Z8 Encore! XP 
based Flash devices. In a production environment, a manufacturing engi-
neer uses an advanced Smart Flash Programmer configuration interface in 
the tool to create Flash project files. These project files store the settings 
that configure the Smart Flash Programmer in the tool to burn Flash mem-
ory on a specific Z8 Encore! target.

Once a project is configured, factory technicians use the simplified Smart 
Flash Programmer interface to automate Flash memory programming on 
an assembly line.

This user manual provides instructions that support:

• Smart Flash Programmer configuration by a manufacturing engineer 
or technician. See "Configuration Instructions" on page 4 for details.

• Smart Flash Programmer operation by a factory worker. See "Pro-
gramming Flash Memory" on page 22 for operation instructions.

Tool Requirements
Use of the Z8 Encore! Smart Flash Programmer requires a Serial Smart 
Cable (found in any Z8 Encore! development kit), or a ZiLOG® USB 
Smart Cable (not available for Windows NT). The Smart Cable is used to 
connect your manufacturing PC to a target board.

Supported Operating Systems
MS Windows 98SE, Windows NT 4.0 SP6, Windows 2000 SP4, or Win-
dows XP Pro SP1.
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Recommended Configuration:
• PC running MS Windows XP Pro SP1

• Pentium III/500-MHz processor or higher

• 128-MB RAM or more

• 10-MB hard disk space (for both application and documentation) 

• Super VGA video adapter

• CD-ROM drive for installation

Minimum Configuration:
• PC running MS Windows 98 SE

• Pentium II 233-MHz processor

• 96-MB RAM

• 8-MB hard disk space (application only)

• Super VGA video adapter

• CD-ROM drive for installation

  **Supported Smartcable Interfaces by OS:

Table 1 lists the supported ZiLOG Smart Cable interfaces by operating 
system. USB drivers must be digitally signed with Microsoft hardware 
compatibility.

1. USB to serial cable not provided in kit.

Table 1. Supported ZiLOG Smart Cable Interfaces by Operating System

Windows 98SE Windows NT
Windows 2000 
Pro Window XP Pro

Serial yes yes yes yes

USB1 no no yes yes
Using the Z8 Encore!® Smart Flash Programmer UM017602-0705
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Installation
Perform the following steps to install the software tools:

1. Load the Smart Flash Programmer (SFP) for Z8 Encore! from 
www.zilog.com.

2. Run the executable installation file.

This displays the Installation Wizard.

3. Click Next> to continue with the installation. The License Agreement 
appears.

4. Select Yes to accept the agreement and proceed with the installation.

5. After selecting Yes, the Choose Destination Location screen appears. 
Follow the directions on the screen and choose whether to install ZDS 
II in the default location or in some other folder. Click Next>.

Unless you select a different location, the software is installed in:
C:\Program Files\ZiLOG\Z8Encore!SFP_<version>\

6. The Select Program folder screen appears. Follow the directions on 
the screen and click Next>.

Unless you select a different location, the program is located in the 
Start menu under

Programs > ZiLOG Z8 Encore! Smart Flash Programmer <version>

7. When the installation is complete, you can select to read and/or 
launch the application.

8. Click Finish.
UM017602-0705 Using the Z8 Encore!® Smart Flash Programmer
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Configuration Instructions
Smart Flash Programmer settings are stored in project files. To create a 
project file, the manufacturing engineer specifies a file name and config-
ures the project to support Flash memory programming of a specific Z8 
Encore! target.

A Note About Serialization
Serialization is the ability to store customer identifier information – such 
as a serial number or Internet address – into Flash memory. You can pro-
gram unique values into Flash, or set an initial value and uniformly incre-
ment it. Serialization is a useful tool and is not required to program Flash.

Create a Project File
1. When you start the Z8 Encore! Smart Flash Programmer after instal-

lation, the Project File Selection window appears (Figure 1).

If you have already configured projects in the Smart Flash Program-
mer, it will open the project file that was last used.

Figure 1. Smart Flash Programmer – Project File Selection Window
Using the Z8 Encore!® Smart Flash Programmer UM017602-0705
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2. Click New.

The Project Creation window appears (Figure 2).

Figure 2. Smart Flash Programmer – Project Creation Window

3. Click the  button.

The New Project File Selection window appears (Figure 3).
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Figure 3. Smart Flash Programmer – New Project File Selection 
Window

4. Double-click the folder in which to store the new project. (It is a good 
practice to create a specific folder that holds all projects.)

5. In the File name: field, enter a file name for the new project. Use a 
legitimate Windows filename. Do not enter an extension.

6. Press Save.

The New Project File Selection Window closes and the Project File 
field in the Project Creation window contains the folder and file name 
specified.
Using the Z8 Encore!® Smart Flash Programmer UM017602-0705



Z8 Encore!® Smart Flash Programmer
User Manual

7

7. Select a Z8 Encore! CPU family from the CPU Family: drop-down 
menu.

8. Select a Z8 Encore! CPU from the CPU: drop-down menu.

9. You must now create a Target Description for the target device to be 
programmed.

Create a Target Device
1. In the Target Selection section of the Project Creation window, dou-

ble-click <New Target>.

The Target Settings window appears (Figure 4).

Figure 4. Smart Flash Programmer – Target Settings Window
UM017602-0705 Using the Z8 Encore!® Smart Flash Programmer



Z8 Encore!® Smart Flash Programmer
User Manual

8

2. Enter a descriptive name into the Target Name: field. The name must 
be a legitimate Windows file name. It is a best practice to use file 
names that uniquely describe the new target. Such a file name can 
include, for example, CPU and communications setting.

3. Verify that the CPU Family and CPU fields contain the correct 
entries.

4. In the Communications Settings section, select:
– Type: Serial or USB

NOTE: If USB is selected, a serial number option is available. If only 
one ZiLOG USB device is connected, the serial number for that 
device appears automatically in the window. If more than one ZiLOG 
USB device is attached to the manufacturing PC, enter the serial num-
ber for the USB device selected.
– COM Port (if type is Serial)
– Baud Rate (if type is Serial)

5. Click .

The Target Clock Settings window appears (Figure 5).
Using the Z8 Encore!® Smart Flash Programmer UM017602-0705
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Figure 5. Smart Flash Programmer – Target Clock Settings Window

6. Select the appropriate target clock setting.

7. Click .

8. The Target Creation Summary window appears (Figure 6).
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Figure 6. Smart Flash Programmer – Target Creation Summary 
Window

9. If you need to change a target setting, click  until you 
reach the appropriate target setting window.

10. Click  when you have completed setting up the target.

The Project Creation window reappears. The target you created is 
highlighted in the Target Selection list.

11. Click the OK button in the Project Creation window.

The main Smart Flash Programmer window appears (Figure 7). This 
is the interface the manufacturing engineer or the factory technician 
will use once you have completed programmer configuration.
Using the Z8 Encore!® Smart Flash Programmer UM017602-0705
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Figure 7. Smart Flash Programmer – Main Window

Set the Advanced Configuration
1. In the Smart Flash Programmer window, click .

The Advanced Configuration window appears (Figure 8).
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Figure 8. Smart Flash Programmer – Advanced Configuration 
Window

2. The Advanced Configuration window allows you to:
– Calculate the checksum for a specific hex file. (Flash menu.)
– Specify Flash Files to be programmed. (Project tab.)
– Specify Flash File offsets. (Project tab.)
– Configure Serialization. (Project tab.)
Using the Z8 Encore!® Smart Flash Programmer UM017602-0705
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– Change communication settings. (Target HW tab.)
– Change the target system clock settings. (Target HW tab.)

The left side of the window contains a tabbed interface that allows 
you to select project settings and target hardware configuration.

NOTE: Flash files are not required for serialization-only operations.

3. If you want to calculate the checksum for a hex file to be loaded into 
Flash memory:
a. Select Flash --> Calculate File Checksum.

The File Checksum Calculator window appears (Figure 9).
b. Click the  button and browse to the directory containing the 

hex file for which you wish to calculate a checksum.
c. Select a hex file and click OK.
d. In the File Checksum Calculator window, click the Calculate but-

ton.
e. The checksum for the selected hex file is calculated.

4. To specify the Flash Files to be programmed:
a. Click the Project tab.

The current project file name appears in the tab.
b. Click the Flash Files item beneath the project file name.

The right side of the window displays the Flash Files Program-
ming Order field.

c. In the Flash Files Programming Order section, click .
The Flash File Selection dialog window appears (Figure 10).
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Figure 9. Smart Flash Programmer – File Checksum Calculator

Figure 10. Smart Flash Programmer – Flash File Selection Dialog

d. Browse to the folder containing the flash file(s) you want to pro-
gram. Select a file, then click the OK button. You can select mul-
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tiple files by holding down the Ctrl or Shift key and selecting the 
files you wish to program.
The Flash file you selected now appears in the Flash Files Pro-
gramming Order section of the Advanced Configuration window.

e. Repeat steps 3c and 3d for each Flash file to be programmed.

5. After you have selected the Flash files to be programmed, click the 
Settings item in the Project tab.
a. The Settings section appears in the right side of the Advanced 

Configuration window (Figure 11).

Figure 11. Smart Flash Programmer – Flash File Settings Detail, 
Advanced Configuration Window
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b. In the File Offset (Hex): field, enter a hexadecimal file offset 
value, if appropriate. This value applies to every file in the 
project’s Flash Files list.

c. If you want to erase the memory ranges defined in your Flash 
files and/or serialization configuration before programming, 
check Erase Before Programming.

6. If you are using serialization, select Serialization in the Project tab.
a. The Serialization section appears in the right side of the 

Advanced Configuration window ().

Figure 12. Smart Flash Programmer – Serialization Settings Detail, 
Advanced Configuration Window
Using the Z8 Encore!® Smart Flash Programmer UM017602-0705
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b. If you are using serialization, check Include Serialization in Pro-
gramming.

c. In the Address (Hex): field, enter the serialization code address.
d. In the Size in Bytes: field, enter the number of bytes required to 

store the serialized entry.
e. In the Serialization Value section, select the mode of entry for the 

starting serialization value. For example, to enter the serialization 
value as an IP address, check the IP Address radio button. Enter 
the first IP Address in Dotted Decimal notation (192.168.1.30, for 
example)
For MAC addresses a format using hexadecimal numbers and 
colons are used. For example: 00:90:23:1C:45:1B
The entry mode is used for engineer convenience.

f. In the Increment Setting section, select either Hexadecimal or 
Decimal, then enter the value by which the serialization value 
must be incremented.
To decrement the serialization value, select Decimal and enter a 
negative number.

7. The Project Flash settings are now configured.

8. Click the Target HW tab in the Advanced Configuration window. The 
Advanced Configuration window displays target information 
(Figure 13).

The Target HW section displays the target you created, and the Target 
Details provides a summary of the target settings.

If you wish to change target communication settings, select the  
Communications item in the Target HW section and change the set-
tings as needed.

If you wish to change target clock settings, select the Clock item in 
the Target HW section and change the settings as needed.
UM017602-0705 Using the Z8 Encore!® Smart Flash Programmer
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Figure 13. Smart Flash Programmer – Advanced Configuration 
Window, Target HW Tab

Other Functions Available in the Advanced Configuration  
Window

There are several other functions available through the Advanced Config-
uration window: Manage targets, program flash, verify flash, erase flash, 
and program a single, unique value into flash.
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Manage Targets
To manage the available target configurations in the Smart Flash Pro-
grammer:

1. In the Advanced Configuration window, open Target → Manage Tar-
gets...

The Target Manager Window appears (Figure 14).

Figure 14. Smart Flash Programmer – Target Manager Window

2. To create a target, click  and follow the instructions in 
"Create a Target Device" on page 7.
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3. To rename a target:
a. Select it and click .

The Name the New Target window appears (Figure 15).

Figure 15. Smart Flash Programmer – Name the New Target Window

b. Enter the new name for the target and press the OK button.
The target name changes.

4. To copy a target configuration to a new target:
a. Select the target you wish to copy and click .

The Name the New Target window appears.
b. Enter the name for the new target and press the OK button.

The new target appears in the Target Selection list.

5. To delete a target configuration:
a. Select the target you wish to delete and click .

The system prompts you to confirm the deletion.
b. Select Yes to confirm deletion, or No to cancel.

Program Flash on an Attached Target
To program Flash on a target device with the currently open project file:

1. Connect your manufacturing PC to the target board containing the Z8 
Encore! device to be programmed.
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2. Click one of the following buttons:

–  – Program the attached target and verify.

–  – Program the attached target, no verification.

Verify Program Stored in Flash on an Attached Target
To verify the program stored in Flash on an attached target, ensure the tar-
get is properly connected and click

 

The status window indicates verification progress. If verification fails, the 
status window displays the failing file and memory location.

Erase Flash on an Attached Target
To set all bits in Flash on an attached target to 1, ensure the target is prop-
erly connected and click

Writing 1s to all memory locations is considered erasing Flash memory.

Program a Single Value in Flash on an Attached Target
The Program Single Value function is a serialization feature that programs 
a single, unique value into Flash memory on an attached target. Before 
programming a single value, ensure that serialization values for address 
and byte size are properly configured.

To program a single, unique value into Flash on an attached target:
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1. Ensure the target is properly connected to the manufacturing PC.

2. Click .

The Program Single Value window appears.

Figure 16. Smart Flash Programmer – Program Single Value Window

3. Select the mode of entry for the value to be programmed (Hexadeci-
mal, Decimal, IP Address, or MAC Address.

4. Enter the value to be programmed.

5. Click .

The value you entered is programmed into Flash memory on the 
attached target.

You can also read the value programmed into the attached target. To do 
so, ensure the target is attached and click .

Programming Flash Memory
The instructions in this section describe a suggested Flash programming 
workflow for manufacturing use. This section is designed to be removed 
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from the manual and used to assemble a custom set of manufacturing test 
instructions.

The basic steps for using the Smart Flash Programmer are:

• Connect the manufacturing PC to the target board using a ZiLOG 
Smart Cable. Refer to your manufacturing test instructions for con-
nection details.

• Start the Smart Flash Programmer and load the correct Flash project 
file.

• Flash the target board.

• Disconnect the target board and connect another.

Program Flash on an Attached Target
To program Flash on a target device with the currently open project file 
and automatically verify that Flash was properly programmed:

1. Connect your manufacturing PC to the target board containing the Z8 
Encore! device to be programmed.

2. Open the File menu and click Open. A file selection window appears. 
Select the project file to be programmed and click Open.

3. Click  .

The status window indicates programming and verification status. If 
verification fails, the status window indicates the file that failed and 
the associated memory location.

4. When the status window indicates that verification is complete, dis-
connect the target board and connect a new target board.

5. Repeat Steps 2 through 4.
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Fast Program Flash on an Attached Target
The Fast Program function programs Flash on a target device with the 
open project file. No verification is performed. To fast program Flash on a 
target device:

1. Connect your manufacturing PC to the target board containing the Z8 
Encore! device to be programmed.

2. Open the File menu and click Open. A file selection window appears. 
Select the project file to be programmed and click Open.

3. Click .

The status window indicates programming status.

4. When the status window indicates that programming is complete, dis-
connect the target board and connect a new target board.

5. Repeat Steps 2 through 4.

Verify Program Stored in Flash on an Attached Target
To verify the program stored in Flash on an attached target, ensure the tar-
get is properly connected and click . 

The status window indicates whether the verification was successful. If 
verification fails, the status window indicates the file that failed and the 
associated memory location.

Erase Flash on an Attached Target
To set all bits in Flash memory on an attached target to 1, ensure the target 
is properly connected and click .

Writing 1s to all memory locations is considered erasing Flash memory.
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Program a Single Value in Flash on an Attached Target
The Program Single Value function is a serialization feature that programs 
a single, unique value into Flash memory on an attached target. Before 
programming a single value, ensure that serialization values for address 
and byte size are properly configured, since they are used to determine the 
memory location for the single value.

To program a single, unique value into Flash on an attached target:

1. Ensure the target is properly connected to the manufacturing PC.

2. Click .

The Program Single Value window appears.

Figure 17. Smart Flash Programmer – Program Single Value Window

3. Select the format of entry for the value to be programmed (Hexadeci-
mal, Decimal, IP Address, or MAC Address.

4. Click ,

The value you entered is programmed into Flash memory on the 
attached target at the memory location specified in Serialization set-
tings.
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You can also read the value programmed into the attached target. To do 
so, ensure the target is attached and click . The Smart Flash 
Programmer returns the value of the data stored in the location defined by 
the Serialization settings.

Starting the Smart Flash Programmer from a Command Line
You can run the Smart Flash Programmer from an Windows command 
line and use command-line switches to specify what it does on startup.

Command syntax:
c:\[installation_path]\bin\zdsflash [<project_file>]|[-s] [-l <log_file>][-h]

Switches:

• <project_file> – Specify a project file name to load

• -s – Cause the Smart Flash Programmer to display the project selec-
tion dialog on startup.

• -l <log_file> – Change the name of the default log file created for the 
new session.

• -h – Display a usage summary for the Smart Flash Programmer com-
mand line launch options.

For example, to load the project file c:\flash_files\my_project.zfpproj 
from the command line, enter:

c:\[installation_path]\bin\zdsflash c:\flash_files\my_project.zfpproj
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Customer Feedback
If you note any inaccuracies while reading this User Manual, please copy and complete this form, 
then send it to ZiLOG (http://support.zilog.com). We also welcome your suggestions!
Product Information

Customer Information

Problem Description or Suggestion
Provide a complete description of the problem or your suggestion. If you are reporting a specific 
problem, include all steps leading up to the occurrence of the problem. Attach additional pages as 
necessary.

Z8 Encore!® Smart Flash 
Programmer
Serial # or Board Fab #/Rev. #
Software Version
Document Number
Host Computer Description/Type

Name Country
Company Phone
Address Fax
City/State/Zip E-Mail
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